
Read Me
Pro Tools and Pro Tools | Ultimate Software 2020.9
on macOS 10.13.6, 10.14.6, and 10.15.6

This Read Me documents important compatibility information and known issues for Pro Tools® and Pro Tools | Utimate Software 
2020.9 on macOS 10.13.6 (“High Sierra”), 10.14.6 (“Mojave”), and 10.15.6 (“Catalina”).

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations.

General Compatibility

Pro Tools would like to access files on a removable volume. (PT-256794)

macOS 10.15 (“Catalina”) introduces a new dialog that controls application access to external volumes. You may encounter this dialog 
when launching Pro Tools or when mounting a new volume with Pro Tools open. Clicking OK lets Pro Tools see the media on this vol-
ume for use with sessions, as well as an available volume in the Workspace. It is recommended that you click OK, but even if you click 
Don't Allow instead you can still allow this later in the macOS System Preferences > Security & Privacy settings.

Pro Tools legacy key commands in the Import Audio dialog conflict with Finder commands in Catalina (PT-257178)

The legacy keyboard shortcuts in the Import Audio dialog no longer function as expected on macOS Catalina. The legacy shortcuts 
continue to work on macOS Mohave and earlier. The legacy key commands have been remapped to new shortcuts for use with a 
QWERTY keyboard in the Import Audio dialog on macOS Catalina and later. 

Also note that on macOS Catalina, the spacebar plays files in the Finder rather than audio in the Import Audio dialog.

For detailed compatibility information, including supported operating systems, visit the Pro Tools compatibility pages online.

For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit the Avid 
website (www.avid.com/compatibility).

Remapping of legacy key commands in Audio Import dialog for macOS Catalina

Legacy Key Command New Key Command Key Command Function Legacy Catalina Function

Command+W Control+W Select Done Choose Cancel

Command+I Control+I Import selected file reveals file in Finder and opens 
Get Info

Command+Option+I Control+Option+I Import selected files N/A

Command+R Control+R Remove selected file Reveal file in Finder

Command+Option+R Control+Option+R Remove selected files N/A

Command+C Control+C Copy selected file N/A

Command+Option+C Control+Option+C Copy selected files N/A
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“Audio Input for Pro Tools is disabled.” on Mojave. (PT-247690)

macOS 10.14 (“Mojave”) introduced a system preference that blocks access to “the microphone” unless you explicitly allow it on a per 
application basis. This preference affects not only microphones but all audio inputs. Pro Tools must be allowed access in order for it 
to use any audio inputs. When Pro Tools is launched for the first time, it posts a warning dialog with instructions on how to grant access.

Afterwards, an OS warning dialog opens, prompting you to allow Pro Tools access to the microphone. Click OK to enable audio inputs.

If you previously clicked Don’t Allow, or the OS warning did not appear for some reason, you can manually allow microphone access 
by going to System Preferences > Security and Privacy > Privacy > Microphone and enable Pro Tools.
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If Pro Tools detects that it does not have microphone access, instructions are be posted each time Pro Tools is launched. Click Open Sys-

tem Prefs and enable Microphone access for Pro Tools.

Pro Tools session closes unexpectedly when removing headphones from the headphone jack on newer MacBook Pros 
(PT-247965)

When working with the built-in audio of some newer MacBook or MacBook Pros, unplugging headphones during use may trigger a di-
alog that the I/O layout has been changed by another application. There is currently no workaround for this, so be sure to save and close 
your session before unplugging from the headphone jack.

On some macOS systems Pro Tools may display the warning dialog “IO channel count for current playback device has 
changed. Please restart Pro Tools” at first launch during Audio Engine initialization. (PT-260818)

When Pro Tools is installed on a clean macOS system, the very first launch may result in a warning dialog shown during Audio Engine 
initialization: “IO channel count for current playback device has changed. Please restart Pro Tools.” After the restart, Pro Tools launches 
normally using the available playback engine.

“The plug-in could not be made active because an AAE error was encountered. AAE error –7054 was encountered.” (PT-233109)

With Pro Tools 2019.5 (or higher) and Media Composer 2018.12 or Media Composer 2018.12.1 co-installed on your computer, you will 
encounter the following after uninstalling Media Composer, and then launching Pro Tools and creating or opening a session: “The plug-
in could not be made active because an AAE error was encountered. AAE error –7054 was encountered.” If this occurs, quit and re-
launch Pro Tools, and the error will not occur again.

Performance issues may occur when using EuControl with the H/W Buffer Size set to 32 in large sessions on macOs. 
(PT-248711)

When working with large sessions with the H/W Buffer Size set to 32, and with EUCON enabled, may result in CPU spikes and AAE 
–6101 errors during playback. If your session exceeds 500 audio tracks it is recommended that you use H/W Buffer Size of 64 or larger 
when EUCON is enabled.

Pro Tools 12 and higher does not support video capture (PTSW-181456)

Pro Tools 12 and higher does not have the ability to record video to the timeline. Use another application or a lower version of Pro Tools 
with a supported video peripheral to capture video and then import it into Pro Tools 12 or higher sessions.

Avid Video Engine (AVE) is not supported with drives that are case-sensitive formatted (UME-1223)

The Avid Video Engine (AVE) will not load on macOS if the OS drive/volume is formatted as macOS Extended (Case-sensitive, Jour-
naled). In order for AVE to load, the OS drive/volume must be formatted as macOS Extended (Journaled).

Pro Tools 12 and higher does not allow import of WMA files (PTSW-181506)

If you attempt to import a WMA file into a Pro Tools 12 or higher session, Pro Tools cannot convert the file and posts a “file is unread-
able” message. Co-install Pro Tools 10.3.10 (or higher) on the same system, import the WMA file, and convert it to a format supported 
by Pro Tools 12 and higher.
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Single track direct output exports from Media Composer may appear in the wrong channel when imported to Pro Tools. 
(PT-247229)

(Pro Tools | Ultimate and Media Composer | Ultimate Only)

Using Pro Tools 2018.12 or higher and Media Composer 2018.10 or higher, iIf a single track is exported from Media Composer and the 
Direct Output, One File, .Wav file export options are enabled, the file may import into Pro Tools with the wrong channel order. To avoid 
this issue, select the File Per Track, 5.1, or 7.1 export options in Media Composer. This results in a single file that will import into Pro 
Tools with the correct channel order. Another option is to export multiple tracks with the Direct Output setting enabled. This results in 
a single file that Pro Tools treats as consisting of all mono channels.

Grid mode shortcut (F4) doesn't select or toggle Grid mode on late 2016 MacBook Pro with Touch Bar if a web browser is 
launched with a web page loaded (PT-224790)

The “F4” function key on a TouchBar of the 4th generation MacBook Pro (late 2016) doesn't select or toggle Grid mode if a Web 
Browser (e.g., Safari or Google Chrome) is launched with a web page loaded (e.g., Google Homepage). Close the Web browser while 
working in Pro Tools to avoid this issue.

Some contextual menus are not accessible using a key modifier and Left-click (PT-218014)

Not all contextual menus can be viewed using a key modifier and Left-click (primary click). For example, Control-clicking a plug-in pa-
rameter cannot access its contextual menu because Control is an isolating modifier for plug-ins. Be sure to enable Secondary Click in 
the Mouse System Preferences (Apple menu > System Preferences > Mouse), and the use the secondary button on your two-button 
mouse (typically Right-click) to access all contextual menus in Pro Tools.

After creating a new user account on macOS, you can initially only save a Pro Tools session in a non-local folder called 
“Documents” (PT-204548)

To avoid this issue, create a folder named “Documents,” save a session there, then save the session and all other subsequent sessions 
wherever you wish.

Warning displayed when opening a session or project created in Pro Tools 12.6 or higher in a lower version of Pro Tools 
(PT-220349)

Any session or project created with Pro Tools 12.6 or higher presents a warning when opened in a lower version of Pro Tools (such as 
Pro Tools 12.5). When the session is opened following this warning, any clip effects data will be dropped from that session or project. 
If you save the session or project in the lower version of Pro Tools, the Save As dialog opens instead so that you do not overwrite the 
original 12.6 or higher session or project.

HD Driver kernel extension does not load if allowed during driver installation. (PT-235980) 

When Open Security preferences button appears during installation, click OK. After restart, the HD Driver kernel extension should load.

Installing the Avid HD Driver 12.6.1 or higher with any lower version of Pro Tools, Pro Tools HD, or Pro Tools First results in an 
AAE –1133 error on launch of the lower version of Pro Tools (PT-223011)

Avid recommends that you do not install and use versions of Pro Tools, Pro Tools HD, or Pro Tools First lower than 12.6.1 with the Avid 
HD Driver 12.6.1 or higher. If you must do so, please uninstall the Avid HD Driver 12.6.1 (or higher) and install a lower version of the 
Avid HD Driver. Alternatively, when launching any version of Pro Tools lowest than 12.6.1 on an HDX or HD Native system with the 
Avid HD Driver 12.6.1 or higher installed, press and hold the N key on launch and select a different Playback Engine than the Avid HD 
Driver (HDX or HD Native).

Pro Tools 12 sessions or higher that use more than 4 gigabytes of RAM will cause Pro Tools 10 or lower to quit unexpectedly 
(PTSW-181963)

If you attempt to open a Pro Tools 12 or higher session that uses more than 4 gigabytes of RAM in Pro Tools 10 or lower, Pro Tools will 
quit unexpectedly. To open such sessions in Pro Tools 10 or lower, first reduce the amount of session RAM usage to less than 4 giga-
bytes in Pro Tools 12 or higher by removing virtual instruments that take up system memory.

Nudge Selected Clip Gain shortcuts may conflict with the default macOS shortcuts for Mission Control (PT-210366)

Performing the Nudge Selected Clip Gain Up/Down shortcuts may trigger Mission Control functions in some versions of macOS. To 
avoid this conflict, click the Keyboard icon in System Preferences, select the Shortcuts tab and then Mission Control from the sidebar. 
Disable or reassign the Mission Control and Application Windows shortcuts.
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Enable Spotlight for best performance when relinking files and indexing in the Workspace (PTSW-183818)

For best performance with relinking and Workspace indexing, enable Spotlight. While enabling Spotlight is not required, it will improve 
performance in this area with Pro Tools.

macOS VoiceOver does not work with Revision History or Soundbase (PT-224341)

The Versions list in the Revision History window and Soundbase do not support macOS VoiceOver (System Preferences > Accessibility 

> VoiceOver) at this time.

OMF files that contain video are not compatible with Pro Tools 12 (PTSW-184397)

OMF sequences that contain video cannot be imported into Pro Tools 12. OMF sequences that contain embedded or referenced audio 
files can be imported into Pro Tools 12. To import a sequence that contains video media, use a linked AAF sequence.

Changing Waveform Cache Versions preference blocks certain features within Soundminer (PT-228201)

If Soundminer is installed, keep the “Waveform Cache Versions” preference setting at zero, its default value. Setting this preference to 
a different value may prevent Soundminer from determining the path to the currently open Pro Tools session, which will block certain 
features within Soundminer.

Soundminer “Spot to DAW” does not work if Pro Tools preferences are corrupted (PT-230027)

If you can no longer spot to Pro Tools from Soundminer even though audio files are actually copied to the audio files folder. If this issue 
occurs, quit Pro Tools, clear the Pro Tools preferences, and relaunch Pro Tools. 

Pro Tools | HDX and Pro Tools | HD Native Systems

HD Driver may not load on macOS Catalina after installing Pro Tools (PT-257898)

When installing Pro Tools version 2019.12 and HD Driver version 2019.12 or later on macOS Catalina, HDX cards may not be detected 
when rebooting the computer. To correct this issue, do one of the following:

• Manually load DigiDal.kext after every boot; Launch the Terminal and enter:

sudo kextload /Library/Extensions/DigiDal.kext 

• For a more permanent solution, force an update of the pre-linked kernel via Recovery Mode in the Terminal:

touch -c "/Volumes/Macintosh HD/System/Library/Extensions" 

When running the Uninstall HD Driver.command, macOS claims that the command is from an unidentified developer and 
prevents it from running. (PT-256268)

If you encounter this issue, Right-click the command and choose Open.

Installing HDX Firmware reset can result in a Kernel Panic or Blue Screen if more than one card is reset in quick succession. 
(PT-247759)

If an HDX firmware update fails and you reset your hardware to factory default to try again, you may find that attempting to reset more 
than one card at a time can result in a kernel panic on macOS or a blue screen error on Windows. If you encounter this issue, reset the 
firmware on one card at a time. Launch Pro Tools to install the latest firmware on one card, then shutdown and repeat the process on 
each additional card in the system.

Hang on application quit after firmware upgrade or downgrade (PT-250325)

If the Pro Tools launch screen displays "Waiting for Video Engine to Quit" for an extended period of time upon completion of a firm-
ware upgrade or downgrade you can safely force quit Pro Tools and follow the firmware directions by shutting down the computer and 
chassis (if present). The firmware upgrade or downgrade will be successful. The act of force quitting will not affect the firmware up-
grade or downgrade process.

When Spotlight is enabled, long record passes (over 50 minutes) may stop recordings after 50+ minutes. Consider disabling Spotlight 
for long recording sessions and then re-enable it when you are done recording.
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HDX firmware downgrade dialog does not appear in the foreground. (PT-245082)

If the HDX firmware downgrade dialog does not appear in the foreground, it may be hidden behind another application's Window. Use 
the macOS keyboard shortcut Command+Tab to bring the Pro Tools application to the foreground and show the HDX firmware down-
grade dialog.

Slow HDX firmware upgrades or downgrades when running in the background (PT-250326)

If you switch to other applications while upgrading or downgrading your HDX firmware, the firmware upgrade/downgrade process runs 
much slower than expected. To avoid this issue, leave Pro Tools in the foreground and do not run other applications while upgrading 
or downgrading your firmware.

If a DigiReWire client is open when a firmware downgrade is requested, a “Pro Tools quit unexpectedly” warning is displayed 
after quitting Pro Tools. (PT-247346)

If a DigiReWire client (such as Reason or Live) is open when an HDX firmware downgrade is performed, Pro Tools may not quit 
correctly. This dialog can safely be ignored. Should you need to upgrade and downgrade your HDX firmware regularly, avoid having 
a DigiReWire client open when doing so.

In rare instances, powering up after a machine shutdown triggered by a firmware downgrade presents a dialog stating, “Your 
computer was restarted because of a problem.” (PT-245084)

Upon reboot at the completion of a HDX firmware downgrade, you may encounter a dialog stating that your computer was shut down 
because of a problem. This dialog can safely be dismissed and ignored.

HDX firmware update failure on MacBook Pro with Akito Node ThunderBolt 3 PCIe Expansion chassis. (PT-248242)

While the Akito Node ThunderBolt 3 PCIe Expansion chassis, like all ThunderBolt 3 chassis without a ThunderBolt 2 host card, re-
mains unsupported, it is worth noting that attempting a firmware upgrade and downgrade on ThunderBolt 3 chassis may fail and is not 
recommended.

Printing interleaved files with more than 8 channels per track on HDX 2 or greater system results in AAE error -9060. (PT-248851)

Printing interleaved files with more than 8 channels per track (such as 7.1.2) on a system with more than one HDX card will fail with 
AAE error -9060. To avoid this issue, print multi-mono files. 

Reinstalling Pro Tools HD driver results in iLok “License Error–DirectIO.” (PT-245855)

If you encounter iLok “License Error-DirectIO” when reinstalling the HD Driver bundled with the Pro Tools 2018.12 installer on 
Mac OS X Sierra 10.12.6, close the error message and restart your computer. If this doesn't solve the problem, continue with the fol-
lowing:

1 Log in to your Master Account (my.avid.com).

2 Download the latest standalone HD Driver available under My Account > My Products > My Products and Subscriptions.

3 Run the Avid HD Driver Uninstaller from the downloaded disk image to uninstall any previously installed driver.

4 Run the Avid HD Driver Installer from the downloaded disk image.

5 Restart your computer.

VNC remote installation of HD driver on macOS 10.13 “High Sierra” is not allowed. (PT-237444)

Because of new driver extension security features in High Sierra (macOS 10.13), you must install the HD driver using a keyboard and 
mouse on the system to approve the driver extension for it to load on boot. When prompted, click the Allow button in the System Pref-
erences Security & Privacy pane.

Some Mac Pro computers with certain video cards may not have power connections available for Pro Tools | HDX cards 
(PTSW-156545)

Some video cards require power from the motherboard, which is also a requirement for HDX cards. If you have a video card that re-
quires both power connections on the motherboard, a power connection for your HDX cards will not be available. To avoid this prob-
lem, use a video card that does not require more than one power connection to the motherboard.
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With macOS 10.6.8 or higher, it may not be possible to update the firmware on an HD Native PCIe card (PTSW-146374)

When launching Pro Tools HD with an HD Native card on macOS, or press Command+J (Mac) or Control+J (Windows). 10.6.8 or 
higher, a –1164 error may occur. This error indicates that the firmware for the HD Native card cannot be updated from version 1.0 to 
version 1.02 or 1.03. If this error occurs, you can only update the firmware using macOS 10.6.7 or lower. The firmware update can also 
fail when using a Thunderbolt MacBook Pro. To avoid this error, use a Mac without Thunderbolt and use the Avid NativeCardFlasher 
utility to update the HD Native firmware,

Eleven Rack

Eleven® Rack Guitar Window not available in Pro Tools 12 (PTSW-184398)

Pro Tools 12 does not provide the Guitar Window for Eleven Rack that is available in Pro Tools 10 and lower. Avid has made available 
a 64-bit standalone version of the Eleven Rack Control Window found in Pro Tools 10 and earlier. Please see the following page for 
more information about the 64-bit standalone Eleven Rack Editor: http://apps.avid.com/eleven-rack/

VENUE

Restarting a VENUE console, including the changing of system configurations, leads to an audio interface timeout with a 
connected HD Native system (PTSW-183745)

When connecting a HD Native system (PCIe or Thunderbolt) to a VENUE live sound system, VENUE HDx cards acting as your inter-
face to Pro Tools timeout when restarting the VENUE console. This includes changing the VENUE system input configuration between 
stage and HDx sources (Virtual Soundcheck). After timing out, Pro Tools cannot record or playback until you quit and relaunch 
Pro Tools.

S6

S6 Automation Module doesn't fully populate with Pro Tools 2018.1 or later launched. (PT-236983)

In order to see the icons populate on the MTM when using Pro Tools 2018.1 or later with S6 3.6.1 or 3.7. Please update to S6 2018.3 
software to correct this issue.

Dolby Atmos

The Dolby renderer will not connect to 'Localhost' (PT-258935)

Pro Tools is able to establish a connection to the Dolby Atmos Production Suite renderer by manually typing 'localhost' in Peripherals 

> Atmos. This field is case sensitive and must be typed in all lower case in order to make a connection.

Recording audio from Pro Tools to Atmos Local Renderer with no pre-roll results in missing audio and fade in at start of 
recording. (PT-245884)

When recording audio from Pro Tools to the Atmos Local Renderer, if the record pass begins at the start of the source audio, then some 
data (around 200 samples worth) from the beginning of the source audio will not be recorded. There will also be a short fade-in added 
to the recording. If an ADM containing the recording is then exported from the Renderer and imported back to Pro Tools, the missing 
audio will be apparent. To avoid this loss of audio data and associated fade in, always add some pre-roll by beginning the record pass 
at least 1 frame before the start of the source audio.

7.1.2 audio is heard out the incorrect channels (PT-263665)

7.1.2 interleaved files that were created in Pro Tools 2019.6 (and earlier), play audio out incorrect channels if opened in Pro Tools 
2019.10 (or later). Please visit the following knowledge-base article for more details: https://avid.secure.force.com/pkb/articles/re-
adme/Pro-Tools-7-1-2-Channel-Order-Change.

For more information on updating Native card firmware, refer to the following Avid Knowledge Base articles: 
http://avid.force.com/pkb/articles/en_US/troubleshooting/en419331
http://avid.force.com/pkb/articles/en_US/troubleshooting/en429831
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Dolby Atmos object panning for stereo tracks created in Pro Tools 12.8 or 12.8.1 may sound different in Pro Tools 12.8.2 (PT-
232805)

In Pro Tools 12.8 and 12.8.1, internal panning is improperly applied to Stereo Objects before the RMU inputs. Pro Tools 12.8.2 correctly 
applies all object panning metadata in the RMU. Consequently, object panning for stereo tracks created in Pro Tools 12.8 or 12.8.1 may 
sound different in Pro Tools 12.8.2. If you encounter this issue, you may need to change the object panning automation for stereo tracks.

Cannot map busses to Objects when connected to a VPN (PT-228845)

You can map busses to Objects even when not connected to a Renderer as long as Atmos is enabled in the Peripherals dialog. However, 
you may not be able to map busses to Objects if you are using a Virtual Private Network (VPN). To map busses to Objects when offline, 
disconnect from the VPN, map busses to Objects, and then reconnect to the VPN.

An audio driver error may be seen in the Dolby Atmos Renderer upon quitting Pro Tools. (PT-253887)

When using Pro Tools Ultimate with the Dolby Audio Bridge in conjunction with the Dolby Atmos Renderer and HD Hardware, quit-
ting Pro Tools may cause an “Audio Driver Error” in the Dolby Atmos Renderer. If you encounter this while using the Dolby Atmos 
Renderer 3.2 and below, you should reclaim the input/output device in the Dolby Atmos Renderer. If you encounter this while using the 
Dolby Atmos Renderer 3.3 and above, the error is benign and does not require action.

AAE –6101 errors with virtual Core Audio devices when Minimize Additional I/O Latency is enabled (PT-252814)

Minimize Additional I/O Latency may result in AAE -6101 errors when used in conjunction with some Core Audio devices, such as the 
Dolby Audio Bridge or Sound Flower. To avoid this issue, disable Minimize Additional I/O Latency when one of these devices is se-
lected for the Pro Tools Playback Engine.

AAE –6101 error encountered while using Dolby Audio Bridge with the Dolby Atmos Production Suite. (PT-255944)

To avoid AAE –6101 errors, it is recommended to run at the highest possible hardware buffer size when using the Dolby Audio Bridge 
with the Dolby Atmos Production Suite: 1,024 samples at 48 kHz and 2,048 samples at 96 kHz.

Ambisonics

Opening a session with Ambisonics tracks in a version of Pro Tools lower than 12.8.2 may improperly convert Ambisonics 
tracks to 7.1.2 or 7.1 format tracks rather than dropping them (PT-233217)

When opening sessions that contain Ambisonics tracks in versions of Pro Tools lower than 12.8.2, Pro Tools may improperly convert 
Ambisonics tracks to 7.1.2 or 7.1 format tracks rather than dropping them. Since Ambisonics channels do not correspond to speaker-
mapped channels, these tracks should be deleted or made inactive as they are unusable in versions of Pro Tools lower than 12.8.2.

Known Issues
The following sections document known issues you may encounter when using Pro Tools and Pro Tools | Ultimate 2020.9, along with 
workarounds if they exist.

General Pro Tools Issues

No signal on tracks in a session after switching sample rates in the Playback Engine. (PT-256794)

Audio signal can be lost on tracks in a session if you change the sample rate before creating the session. Opening sessions with different 
sample rates should fix this issue for the failed session.
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Pro Tools quits unexpectedly while loading plug-ins on launch (PT-206888)

On Pro Tools systems with several hundred plug-ins installed, Pro Tools may quit unexpectedly on launch. If this occurs, try the fol-
lowing:

• Move approximately 100 plug-ins (or more) from the Plug-Ins folder to the Plug-Ins (Unused) folder (/Library/Application Sup-
port/Avid/Audio/).

• Launch Pro Tools.

• Quit Pro Tools.

• Move the plug-ins back from the Plug-Ins (Unused) folder to the Plug-Ins folder.

• Launch Pro Tools.

Playback and recording fails after switching sessions with H/W Buffer Size set to 2048. (PT-252207)

Depending on the session Sample Rate, it is possible to use 2048 H/W Buffer Size in Pro Tools (sessions with Sample Rate set to 88.2 
kHz or higher). If you then open a session that uses lower Sample Rate setting that does not support a H/W Buffer Size setting of 2048 
(such as 48 kHz), Pro Tools does not playback or record. If you encounter this issue, select a supported H/W Buffer Size, such as 1024, 
in the Playback Engine dialog (Setup > Playback Engine).

Pro Tools quits unexpectedly when importing an ADM file and an IAB/MXF file is in the same location. (PT-248710)

Pro Tools quits unexpectedly when importing an ADM file and an IAB/MXF file is in the same folder. To avoid this issue, move the 
IAB/MXF file to another location, such as in a subfolder.

Tracks List scroll bar gets stuck at high voice counts (PT-236416) 

(Pro Tools | HDX Only)

If you encounter this issue, use scroll wheel on your mouse or trackpad to scroll through the Tracks List.

The Mix Window cannot be expanded past a certain vertical size (PT-236038)

The Pro Tools Mix Window has a vertical size limit. As a result, the window may not be stretched to fill the entire screen on high res-
olution monitors without scaling. If you encounter this issue, it is recommended that either the display be scaled to more fully fit the 
screen, or that you scroll through the Mix Window to view areas that might otherwise be out of view.

Shifting an Edit Group containing frozen tracks removed clips and effect automation on non-frozen tracks (PT-264403)

Shifting the contents of an Edit Group with Frozen Tracks can remove Clips and effect automation on non-frozen tracks. To avoid this 
issue, suspend the group before Shifting the contents.

Data lost while shifting automation across multiple tracks with mixed channel widths. (PT263781) 

When using the Shift command to move automation data on multiple tracks, if one of the tracks is a wider channel width than mono, 
automation on one track can be replaced by automation from another. In some cases, automation can be lost. If this occurs, Shift auto-
mation on tracks of different channel widths separately.

Dense automation results in –9155 Error (PT-249098)

Due to higher voice counts available on Pro Tools Native systems, you might encounter AAE –9155 errors when many automation pa-
rameters are written to multiple tracks on the same sample. If you regularly encounter “AAE –9155 Automation Too Dense” error mes-
sages at the exact same point try the following:

• Select all automation and choose Edit > Thin All Automation.

• If the session contains many parameters written at the exact same spot, try removing some of the unnecessary automation by de-
leting it or changing the Automation mode from Read to Off on respective tracks.

• If the Automation was written to any unnecessary tracks in the session, make those tracks Inactive.

• Select the suspect automation and nudge it by a sample or two.
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Key command to toggle between Edit and Mix windows (Command+=). (PT-236979)

When either the Mix or Edit window appears fully expanded it is necessary to press Command+= twice to toggle between windows. To 
avoid this issue, Option-click when zooming in the Mix or Edit window to prevent it from expanding to full screen. Also, the app 
“Moom” can be used to more efficiently navigate windows on Mac and avoid this issue.

The OK button is missing in the Preferences window with a small screen setting. (PT-234486) 

If the OK button is not visible in the Preferences window, press Return to save and close the Preferences window (or press Command+. 
to cancel).

OK button in the Tempo Change dialog is grayed out after using manual tempo in a previous session. (PT-235174)

If you encounter this issue, toggle the Conductor button off and on. The OK button should then be usable in the Tempo Change dialog.

Opening and closing windows using the macOS tabs feature can result in UI artifacts (PT-237395)

If System Preferences > Dock > “Prefer tabs when opening documents” is set to “Always,” graphic artifacts may be encountered when 
opening and closing new windows. To avoid this issue, use any other setting in the System Preferences. If you encounter this issue, re-
sizing the Pro Tools window forces a graphic redraw and any artifacts will disappear.

Pro Tools quits unexpectedly when importing a track during playback (PT-234220)

Pro Tools may quit unexpectedly when importing an audio track from another session (Import Session Data) during playback where the 
imported track replaces an audio track in the session that is being played back during the import. If this occurs, restart Pro Tools and re-
open the session. To avoid this problem, stop playback before importing audio tracks from another session.

Pro Tools does not play back immediately after importing a large and complex AAF sequence (UME-905)

Importing a complex AAF sequence that contains many video files and edits may cause Pro Tools to be in a Play/Pause state after all 
files have finished linking. This may also happen when reopening the session. If you encounter this, stop the transport, wait 30 seconds, 
and then attempt playback again. To avoid this problem completely, you can bounce the video and re-import, or request that the video 
editor flatten the video upon export.

Pro Tools 19.10 and later does not automatically link to WAV files upon OMF import. (PT-257172)

When importing an OMF that references BWF WAV media into Pro Tools 19.10 and later, the associated WAV files do not link auto-
matically and are identified as missing. This occurs even if the media is placed in the same folder as the OMF, and all file attributes 
match. To bring the media online, perform a manual relink when prompted. Note this only occurs with OMF; AAF is unaffected.

AAF-associated WAV files exported from Pro Tools 2019.12 will not AMA-Link in Media Composer 2019.11. (PT-256851)

If an AAF referencing WAV files is exported from PT 2019.12 and then imported into Media Composer 2019.11 (and earlier) using 
AMA-Linking, the WAV media is offline. To bring the media online, place the exported WAV media into an OMFI MediaFiles folder 
accessible by Media Composer.

Import Session Data with “Match Tracks” and “Main Output Assignments” option disabled adds the source track’s output 
assignment (PT-231313)

Multiple outputs can be assigned to a track if Import Session Data with “Match Tracks” was used even after toggling the “Main Output 
Assignment” option of the source track. If you encounter this issue, manually restore the original output assignment of the track.

When Saving a Track Preset, the parent folder cannot be selected with mouse click or arrow key in the Add Category menu if 
there is a selection in nested sub-folder (PT-236697 and PT-237166)

If there is a selection in a nested folder in the Add Category menu in the Save Track Preset dialog, you must first navigate to the parent 
folder and deselected the nested sub-folder in order to be able to select the parent folder.

Pro Tools reports AAE Error 2 (PT-210384)

You may encounter AAE Error 2 if you have two or more volumes on your system with the same name. To avoid this issue, ensure that 
each volume on your system is uniquely named.
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Mono (Summed) option in the Bounce to Disk window disappears after Bouncing (PT-255617)

The File Format > Mono (Summed) option in the Bounce to Disk window disappears after bouncing a file to two Bounce sources. To 
correct this, open the Bounce to Disk window, delete the second Bounce source, then re-open the Bounce to Disk window and add the 
second bounce source again.

Pro Tools becomes unresponsive when bouncing certain multichannel paths to MP3 (PT-217391)

The only multichannel format Pro Tools supports for bouncing to MP3 is 5.1. Bouncing any other multichannel format to MP3 (LCR, 
LCRS, QUAD, 5.0, 6.1, 7.0 SDDS, 7.1 SDDS, 7.0, and 7.1) results in Pro Tools becoming unresponsive and you will have to force quit. 

Offline Bounce takes much longer than expected (PT-202888)

Offline Bounce times can increase significantly in sessions that have output and input assignments cascaded across tracks (for example: 
Track 1 output is assigned to Track 2 input, Track 2 output is assigned to Track 3 input, and so on).

Three-hour Bounce to QuickTime results in timeout. (PT-237050)

When bouncing to QuickTime at a length of 3 hours (or more), the bounce may fail due to a timeout waiting for AVE. This is issue oc-
curs intermittently, and rarely. The only known workaround is to simply Bounce to QuickTime again.

When importing session data, automation is replaced instead of overlaid when using Adjust Session Start Time to Match 
Source Start Time (PTSW-149273)

Automation can sometimes be replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when im-
porting session data. This issue may occur if the source session start time (of the session being imported) is earlier than the current ses-
sion start time. This issue can be avoided if you instead import the session data from the session with the later start time into the session 
with the earlier start time. You must also not enable the Adjust Session Start Time to Match Source Start Time option, and select Main-
tain Absolute when prompted.

Auto Low Latency Monitoring is lost when opening a session created in Pro Tools 12.6 or higher in versions of Pro Tools lower 
than 12.6 (PT-219356)

If a session is saved with Auto Low Latency Monitoring (“Blue Mode”) enabled in 12.6 or higher, it is disabled when that session is 
opened in versions of Pro Tools lower than 12.6 (in 12.5 for example). You will have to re-enable Auto Low Latency Monitoring if de-
sired. This issue does not occur when opening sessions in Pro Tools 12.6 and higher that were saved with Auto Low Latency Monitoring 
enabled in a version of Pro Tools lower than 12.6.

No sound when previewing audio files in Workspace if Delay Compensation was enabled during playback (PT-229609)

If you enable Delay Compensation during both session playback and audio file preview in a Workspace browser, Workspace preview 
is silent until session playback is stopped. To avoid this issue, enable Delay Compensation before starting session playback and preview 
in a Workspace browser.

Automatic Delay Compensation cannot not be applied to tracks recording from different types of sources (PTSW-157960)

Automatic Delay Compensation cannot compensate for cascaded records that use both I/O and bus inputs to recording tracks. An ex-
ample of this is feeding an audio track (in record) from an audio input, and then bussing the output of the track to another audio track 
also in record. The first audio track will be compensated but the second cascaded track will not be. (This is not a common workflow.)

Cannot run Reason as ReWire clients if they have not first been launched and set up as a standalone application (PTSW-133070)

Reason needs to be launched and setup as a stand-alone applications before running them as a ReWire clients with Pro Tools. Do the 
following:

• Launch Reason in stand-alone mode and follow the on-screen instructions.

• Quit Reason.

• Launch Pro Tools and insert Reason as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.
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Exporting interleaved BWF files from Pro Tools 10 or higher and importing into Pro Tools 9.0.x and lower may cause Pro Tools 
to quit unexpectedly (PTSW-151579)

When exporting any greater-than-stereo multichannel interleaved WAV (BWF) files other than 5.1 from Pro Tools 10 or higher and 
then importing them into Pro Tools 9.x or lower, Pro Tools quits unexpectedly. To avoid this problem, export audio files for import into 
lower versions of Pro Tools in another file format (such as AIFF or multi-mono).

AAF files that contain AMA-linked audio cannot be imported (PTSW-182322)

Pro Tools cannot import AAF files that contain AMA-linked audio files. AMA-linked audio must be imported or transcoded in 
Media Composer before the AAF is exported.

Rendering Clip Gain or Clip Effects on multi-channel audio clips in an interleaved session results in multi-mono files 
(PT-214780)

In an interleaved session, rendering Clip Gain or Clip Effects on a multichannel audio clip creates mono audio files for each channel 
rather than the expected single interleaved, multichannel audio file.

Real-Time Fade Adjustment Tool can display the fade preview outside of the Timeline under certain Window Scrolling 
conditions (PT-220418)

If the area before the start of the Timeline is visible when using Continuous Window Scrolling or if the Center Playhead option is en-
abled, and the area before the start of the timeline appears on-screen, then adjusting a fade using the Real-Time Fade Adjustment Tool 
can cause the fade preview to appear outside of the fade boundary or Timeline. To avoid this issue, only use the Real-Time Fade Ad-
justment Tool in No Scrolling, After Playback, Page scrolling modes, or when the start of the Timeline is off-screen.

Recording track group output featuring 90º volume automation changes while writing VCA automation can result in unwanted 
fades (PT-222834)

If audio clips on a track within a track group feature sharp 90º volume automation changes and the track group has a VCA assigned to 
it, bus recording the output of the audio track to another audio track while VCA automation is being written may result in the new re-
corded audio fading in and out around the 90º volume automation changes. To avoid this issue, record any VCA automation first and 
then record the track group output in a separate record pass.

Unrendered mix and match AAFs will not properly import (PTSW-181825)

If the error “A video file and its associated clips were removed because its timecode rate is incompatible with the project type” appears, 
it is likely that your AAF contains unrendered mix and match video. To avoid this, render mix and match AAFs from Media Composer 
before or during export.

Clip names appear incorrect after selecting Field Recorder channel matches, or expanding to new tracks (PTSW-136012)

This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero. Pro Tools 
names new clips by incrementing the number after the hyphen. If a field recorder file is already named in this way (such as “Filename-
01”), then new clips created by selecting a Field Recorder channel match or by expanding a track may have names different from the 
parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.

Field Recorder matches appear offset after AudioSuite rendering if the session timecode rate does not match the file timecode 
rate (PTSW-152147)

If a portion of a file has been rendered with an AudioSuite plug-in, an offset can occur when expanding field recorder matches in cases 
where the session timecode rate does not match the timecode rate of the audio file. To avoid this issue, you can either render the whole 
file with AudioSuite (rather than only a portion of the file), or use Whole File mode when rendering AudioSuite processing.

External Field Recorder matches do not show up after an initial index pass (PTSW-180659)

If external field recorder matches do not show up on a field recorder track after the initial index pass, save and reopen the session.
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Editing

Fades are not restored after moving clips using the Grabber tool (PT-207491)

With Layered Editing enabled, moving a clip that partially covers a fade on another clip with the Grabber tool so that it no longer covers 
the fade does not restore the fade to its original duration. You will need to manually trim the fade to its original duration

The Undo command does not remove a clip copied to a playlist by virtue of the Send Overlapped Clip to New Playlist preference 
(PT-222824)

When the Send Overlapped Clip to New Playlist preference is enabled, and you move a clip completely over another, the overlapped clip 
is moved to a new playlist. However, if the track is not in Playlists view, Undo restores the clip on the main playlist, but it does not re-
move the clip from the alternate playlist. You will have to manually remove that clip from the alternate playlist if you so desire. 

No indication of designated target playlist in Playlist selector menu (PT-237313)

When a track contains one playlist that is the Target playlist, the blue target icon does not appear next to the playlist name in the Playlist 
menu. This issue is resolved once another playlist is created.

Looping clips does not send fully overlapped clips to an available playlist (PT-219668)

With both Layered Editing option (Options > Layered Editing) and the Send Fully Overlapped Clips to Available Playlist While Editing 
preference enabled (Setup > Preferences > Editing), clips that are fully overlapped by a looped clip (Clip > Loop) are not sent to an avail-
able playlist. Manually move clips that will be fully overlapped by the looped clip to another playlist before looping the clip.

Fully overlapped clip not sent to new playlist if the clip is overlapped by creating a fade (PT-220888)

When a clip is fully overlapped by the creation of a Fade In or Fade Out, the overlapped clip is not sent to a new playlist even though 
the Send Fully Overlapped Clips to Available Playlist While Editing preference is enabled. To avoid this issue, create a shorter fade and 
then extend it to fully overlap the clip in question. That clip is sent to a new playlist. Alternatively, manually move the clip to a new play-
list.

With Layered Editing enabled, deleting overlapping clips that were created with Duplicate or Repeat can result in some 
overlapped clips being unexpectedly edited as well (PT-220491)

With Layered Editing enabled, deleting overlapping clips that were created with Duplicate or Repeat can result in some overlapped clips 
being unexpectedly edited as well depending on the order in which the overlapping clips are deleted. To avoid this issue, delete any over-
lapping clips in order from left to right.

Projects and Collaboration

It is strongly recommended that you do not log in to the same project on multiple systems using the same Avid Master Account 
login

When you are connected to the internet and then you open a Pro Tools Project, Pro Tools checks to see if there are any other machines 
that are logged in to the same Avid Master Account and both with the same project open. If the project is detected as being open on an-
other system it should be closed. This prevents the project bundle on the cloud from becoming corrupted by competing updates from 
multiple systems using the same account. To avoid this situation, it is strongly advised that you close projects when leaving systems idle 
if it is possible that you will be working on the same project from another computer with the same Avid Master Account.

Cloud Client Services window not show and shared track data fails to upload (PT-264649)

When Pro Tools is installed on a clean macOS system, and you then sign in to your Avid Account, create a project from a template, and 
share tracks, the Cloud Client Services window is not always shown and shared data is not uploaded. To correct this issue, save and close 
the project, then click OK when the Cloud Client Services window appears. Restart Pro Tools, and open the project to finish uploading 
data to cloud.

Pro Tools doesn't indicate incoming contact requests (MP-5538)

When using Avid Link in Pro Tools, as opposed to using the desktop client, incoming contact request notifications are visible in the 
Home screen under the Notifications tab. Go to the Avid Link menu and choose Home, then navigate to the Notifications section by 
clicking Notifications.
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“Send Email Invitation” button not present in the Avid Link Find Talent window (MP-5590)

The Send Email Invitation button in the Avid Link Find Talent window might not be visible when it is first opened. Refresh the page by 
clicking on a profile and then clicking the back button. The Send Email Invitation button should now be visible underneath the Search 

Community field. 

Playing back recorded MIDI CC data incorrectly triggers the Upload Track Change button (PT-255960)

When playing back MIDI CC data on a shared MIDI or Instrument track, Pro Tools may incorrectly indicate changes on that track for 
upload. Since clicking the Upload Track Changes button synchronizes the track with server, it is recommended do this until you have 
made additional changes to the track.

Clip Effects settings are lost when sharing tracks with Pro Tools 12.5.x (PT-220478)

Track collaboration between Pro Tools HD 12.6 and lower versions of Pro Tools will result in losing Clip Effects settings on shared 
tracks. Earlier versions of Pro Tools drop clip effects settings from tracks that are shared from Pro Tools HD 12.6. There is no warning 
when Clip Effects settings are lost while collaborating. To avoid this issue, render Clip Effects for all clips with Clip Effects on tracks 
you want to share with any collaborator running a lower version of Pro Tools.

Additional Playlists indicator does not appear on shared tracks with collaborators’ systems (PT-219746)

If you duplicate a playlist on a shared track, the Additional Playlists indicator does not light for collaborators. Subsequently making a 
change to the alternate playlist, however, does notify collaborators.

Projects may not synchronize to Avid Cloud after remaining open overnight (PT-220208)

After a Project has been open for a protracted period of time, saving to the Avid Cloud may not succeed. If you see a Project upload not 
completing in the Task Manager, it is recommended that the Project be saved and closed, and that you sign-out and then back in again. 
You should then be able to complete the Project upload.

After canceling a Project upload, it can take up to two minutes before any remaining uploads in the Task Manager begin 
(PT-220170)

If Project uploads are canceled and other upload tasks remain in the queue, it can take up to two minutes for these uploads to begin. If 
this issues occurs, simply wait for the remaining projects to begin uploading.

Assertions and AAE errors may occur when Project Media Cache exists on multiple identical volumes (PT-213652)

Assertions and AAE errors may occur when the Project Media Cache folder exists on multiple identical volumes. To avoid this issue, 
ensure that the Project Media Cache remains set to different locations on each volume, rename each volume if possible, or unmount any 
identical volumes while working with projects in Pro Tools.

Disconnecting from the internet or closing a project during project synchronization can result in failed project synchronization 
(PT-202643)

To prevent potential synchronization with projects, do not disrupt the project synchronization while it is in progress. Avoid disconnect-
ing from the internet, turning off WiFi, shutting your laptop, or quitting Pro Tools | First during this time. To monitor the progress of 
project synchronization, choose Window >Task Manager.

Removing a collaborator from your project may not relinquish ownership of tracks claimed by that collaborator (PT-211627)

When a collaborator who has ownership over shared tracks is removed from a project that you own, their track ownership may not be 
automatically relinquished. Should this issue occur, click the Track Ownership button for these tracks and ownership should be returned 
to you after about five minutes.

Project uploads may pause while Shuttle Lock is active (PT-213277)

Entering Shuttle Lock mode while project uploads are in progress may temporarily prevent uploads from finishing until the playhead 
comes to a stop. To avoid this issue, confirm that all uploads have completed in the Task Manager before using Shuttle Lock mode in 
a project.
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“Expand Alternates To New Playlists” may not trigger track or project uploads (PT-212809)

When a track has loop-recorded alternates that are not on any playlists, choosing to “Expand Alternates To New Playlists” may not trig-
ger an auto-upload or allow manual uploading using the Track or Toolbar upload buttons. If this issue is encountered, making any 
change or edit to the track or its playlists will enable uploading with the Track upload button.

Edit selection moved to the wrong playlist on a shared track (PT-220200)

On a shared audio track received from a collaborator who reordered the track's playlist lanes (by click-dragging the lanes up and down), 
the Move To... commands in the Right-click menu sends the selection to the wrong playlist. The collaborator reordering lanes and shar-
ing can be on a Mac or Windows system, however, only Windows systems will have the issue on the receiving end. To avoid this issue, 
make sure that collaborators do not manually reorder playlist lanes on shared tracks.

Destructive Punch record passes are not transmitted to collaborators (PT-212577)

Using Destructive Punch to update a shared file does not transmit a track change and the file is not updated on collaborator systems.

Changed Display Name in Artist Chat is not updated in the Dashboard until signing out and signing back in (PT-209796)

After making a change to the Display Name in your Artist Chat profile, the Pro Tools Dashboard is not updated with the new user name 
until you sign out and sign out and back in. 

Artist Chat messages of 1,800 characters or more may not be received or even sent (PT-211701 and PT-214391)

Attempting to send an Artist Chat message of 1,800 or more characters can appear to send but may not be received by other users in the 
chat or they may not be sent at all. The actual maximum limit for Artist Chat messages is 2 kilobytes per message. It is recommended 
that uncommonly long messages be posted in shorter segments.

Dropped Keystrokes in Artist Chat and Sign On Window (PT-211627)

In some cases keyboard keystrokes will fail to be transmitted to the Sign On and Artist Chat windows. 

Pasting a text string inside of the “< >” characters into Artist Chat results in a blank entry (CLOUD-3285)

Any text in contained by “<" and ">” is disallowed for security reasons. Please do not use these characters in Artist Chat messages.

When sharing a track with plug-ins such as Melodyne or Space, only the waveform cache inside the plug-in is uploaded and 
shared, but not the referenced audio file (PT-212607)

Media assets for Plug-ins (such as Melodyne or Space) that use external media, like a waveform cache or impulse responses, may not 
always be copied with the shared tracks to the cloud for use by other collaborators.

Ableton Link

Pro Tools goes out of sync with an Ableton Link session after receiving a tempo change. (PT-263560)

When Pro Tools receives a tempo change while synced to other peers with Ableton Link, it may loose phase alignment synchronization. 
It remains tempo locked, but the position in the cycle is incorrect. This can be corrected by restarting the Pro Tools transport to re-es-
tablish sync.

Count Off is unavailable with Ableton Link

Count Off is unavailable with Ableton Link. If Count Off is enabled, enabling Ableton Link disables Count Off.

I/O Setup

Do not assign the Audition path to Ambisonics Output paths (PT-232689)

Ambisonics Output paths should not be used for audition paths. If you assign an Ambisonics Output path as the Audition path, it will 
not work. Only use non-Ambisonics Outputs paths for the assigned Audition path.
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Master Faders assigned to mapped output busses function only on that specific bus, not for the output channel as a whole 
(PTSW-127517)

Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in which the level 
sent to the physical I/O is not reflected on any meters in the Pro Tools application. If the configuration includes output subpaths or has 
multiple busses assigned to a single output path, the overall signal level from these combined sources (including any clipping indication) 
will only be displayed on the interface itself. You can avoid using multiple output paths or output busses simultaneously by routing your 
sources to a single mapped output bus and assign a Master Fader to that.

Session templates retain Bus settings and some preferences, display settings, and window layouts (PTSW-47133)

Pro Tools session templates retain the bus settings and some of the preferences, display settings, and window layouts from the system 
on which the template was created. Consequently, creating a new session based on a template restores several session properties from 
the original system. These properties are retained by Pro Tools until you change them, or another session or template is opened that re-
places them. This also means that if a new blank session is created after using a template, the properties from the template will be used 
for the new session.

The properties retained from templates include default track height, view settings, window size and position, and bus settings. You can 
update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in 
system” option), and then selecting the template you want to replace.

2nd port of MTRX DigiLink I/O card does not show inactive in the I/O Setup in 192 kHz sessions (PT-252964)

The second DigiLink Mini port on MTRX DigiLink I/O expansion cards is unavailable at sample rates of 176.4 kHz and 192 kHz.

Opening a session saved to .ptf (Pro Tools 7–9) from Pro Tools 12.x or higher in Pro Tools 8.1 or lower results in incorrectly 
mapped IO (PTSW-194443)

For any session saved to .ptf (Pro Tools 7–9) from Pro Tools 12.x or higher requires that IO Settings be manually corrected when open-
ing that session with Pro Tools versions 8.1 and lower. Manually map the correct IO settings in the IO Setup before playing back the 
session.

File and Disk Management

Auto-backups are not created during playback or recording (PT-231812)

Auto-backups are not saved while Pro Tools is playing back or recording. To ensure your work is saved during long periods of playback 
or recording, either manually save during playback or recording, or after stopping playback or recording. Auto-backups continue to 
function as expected when the transport is stopped.

Pro Tools quits unexpectedly when indexing Workspace or Field Recorder Search outside of a session. (PT-251446)

If Pro Tools consistently quits unexpectedly when indexing a directory with the Workspace, or when using the Select Areas to Search 
functionality with field recorder workflows, this might be resolved by trashing your Workspace database files. To do this, clear the con-
tents of the following folder: <boot drive>/Users/Shared/Pro Tools/.

After Relinking files the Relink window does not retain its “revealed/open” status (PTSW-178130)

Although the checkbox remains selected, the reveal status of volumes is not retained if the Relink window is automatically reopened. 
Be sure to reveal the volumes so that the enabled checkboxes are visible in order to reliably relink to missing files. 

When relinking audio files, mismatched channel widths are not found (PTSW-189868)

When relinking audio files, it is possible to link files with different channel widths. This is not a supported workflow and may have un-
predictable results. Ensure that the channel width of linked files match the channel widths of clips in the session to avoid this issue. 
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Elastic Audio

Maintaining phase coherency with Elastic Audio pitch processing (PTSW-20602)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Monophonic or 
Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio Pitch processing 
from the track before switching to the Monophonic or Varispeed algorithm.

Drift in an audio file may occur when using Elastic Audio and the Monophonic or X-Form algorithms (PTSW-33768)

Drift in an audio clip may occur when using elastic audio depending on how much the clips is expanded or compressed when using the 
Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient information in it that you would 
like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.

Default Input Gain preference is only for Elastic Audio imported at session tempo (PTSW-34096)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported at Ses-
sion Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or “Drag and Drop 
from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.

Displayed Timebase is incorrect after importing Elastic Audio tracks (PTSW-46897)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will need to man-
ually select the correct timebase for the affected tracks.

Elastic Audio clips on Playlist lanes are not rendered (PTSW-47311)

In Playlists View, any Elastic Audio clips on Playlist lanes are not rendered (waveform is “off-line”) when changing the track’s Elastic 
Audio processing from Real-Time to Rendered. Using the object grabber to select any off-line clips, promoting them to the main playlist 
or copying and pasting the clips in place will render using the selected Elastic Audio algorithm.

Clip Groups containing Elastic Audio are not recognized as Elastic if the Clip Group itself has not had any Elastic functions 
applied (PTSW-34335)

If a clip group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level of the clip 
group itself, then the clip group will not register as Elastic Audio. When used to create a new track, the track will not automatically be 
Elastic Audio–enabled, and the elastic audio inside the clip group will be rendered using the default Elastic Audio plug-in for the ses-
sion. As a workaround, add a warp marker to the clip group to force it to register as an elastic clip. Or, create an Elastic Audio–enabled 
track first, then add the clip group to it.

Cannot import Elastic Audio tracks with the Consolidate From Source Media option (PTSW-33894)

Use Copy from Source Media to import Elastic Audio tracks. 

Timing inaccuracy in audio files converted from CAF and MP3 with Preview In Context enabled (PTSW-46707)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio and inner-
clip asynchronous transients issues). This is inherent with compressed file formats.

Track Commit and Track Freeze

Frozen Tracks are opened in a partially frozen state in certain versions of Pro Tools 12 (PT-208260)

Opening sessions created in Pro Tools 12.4 that have frozen tracks in Pro Tools 12.0 to 12.2.1 will result in graphical issues for “frozen” 
clips (such as waveforms overlaying clip boundaries, missing clip boundaries, or clip boundaries that move without waveforms), tracks 
and inserts (inserts can be in an inactive/frozen state and cannot be activated). In versions of Pro Tools 11.3.2 and earlier, or Pro Tools 
12.3, these problems do not occur and the track is opened in it's unfrozen state.

Relinking to missing rendered “frozen” Auxiliary Input tracks does not yield any results when reopening a session (PT-210026)

If there is missing rendered audio from frozen Auxiliary Input tracks, they cannot be relinked after first time of reopening a session. Task 
Manager will report: “Some Files to relink Not Found.” To correct this issue, close and reopen the session, and try to relink to the miss-
ing files again.
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Frozen tracks are not translated by AAF and Interplay unless committed (PT-210128)

Only the unprocessed source audio on frozen tracks is translated by AAF and Interplay To ensure that the desired track audio processing 
is translated accurately for AAF sequences (and Avid Interplay), commit those tracks rather than freeze them.

Committing clips on Instrument tracks by dragging them to audio tracks with the Downmixer plug-in may render an incomplete 
clip (PT-207317)

Committing MIDI clips on Instrument tracks by dragging them to audio tracks with Downmixer may render an incomplete clip. Using 
the Grabber tool on these incomplete clips may not function over the incomplete areas of the clip. To avoid this issue, Commit Instru-
ment track clips to new Audio tracks before inserting the Downmixer plug-in.

When committing from two or more Instrument tracks in a session with tempo changes by dragging and dropping to audio 
tracks, and where the Instrument tracks include a mix of sample-based and tick-based tracks, the tick-based committed clip is 
trimmed to match the source MIDI original duration even though the audio committed from tick-based MIDI follows the tempo 
changes (PT-208300)

To avoid this issue, use the Trim tool to reveal the rest of the committed audio or commit sample-based MIDI clips and tick-based clips 
separately.

MIDI

Score Editor is illegible with hundreds of MIDI tracks are in a session. (PT-250083)

Avoid opening the Score Editor when there are hundreds of MIDI tracks in your session. The Score Editor will be illegible when opened 
with many tracks in a session and the showing and hiding of tracks may result in Pro Tools freezing.

Closing a session takes an excessive amount of time when hundreds of MIDI tracks are shown in the Score Editor. (PT-250084)

Avoid opening the Score Editor if you have hundreds of MIDI or Instrument tracks in a session as Pro Tools may quit unexpectedly or 
may freeze (and may need to force quit). If the Score Editor is successfully opened with hundreds of MIDI tracks, closing session will 
take an inordinate amount of time (however a progress bar will be shown). 

When playing an Instrument plug-in using a MIDI controller and recording the MIDI performance and while also bus recording 
the audio output of that plug-in, the recorded MIDI plays back earlier than the recorded audio (PT-201867)

When playing an Instrument plug-in using a MIDI controller, and both recording the MIDI performance and bus recording the audio 
output of the plug-in, the recorded MIDI performance plays back earlier than the recorded audio. This issue can occur when using Pro 
Tools | HDX with Delay Compensation enabled. You can avoid this issue by switching the Playback Engine from HDX to CoreAudio. 
Once you have recorded your MIDI performance and the audio output from the Instrument plug-in, you can switch the Playback Engine 
back to HDX.

When recording MIDI, Wait for Note does not respond to MIDI input from ReWire (PTSW-30511 and PTSW-34550)

When performing a MIDI record, Wait for Note will not respond to any MIDI received from ReWire. If you are recording MIDI gen-
erated from a ReWire application, you will have to start the transport manually or use a countoff instead of Wait for Note.

When using Import Session Data on a MIDI track with Real-Time Properties enabled and set to using Diatonic transposition, 
transposition is based on the first key signature in the session only (PTSW-49297)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the “Transpose 
in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can be corrected by tog-
gling the Real-Time Properties off and on; then the diatonic transposition will be correct for each key.

Key commands to trim MIDI Note On (Control+Left/Right Arrow) conflict with macOS default key commands for switching 
Spaces. (PT-235307)

Due to this conflict, the trim MIDI Note On key commands may not work. To enable these key commands: Open MacOS System Pref-
erences and select Keyboard; select the Shortcuts tab; and then in the left column, select Mission Control. Next, disable or change 
“Move left a space” and “Move right a space” in the right column. Note, you may have to click on the reveal triangle next to Mission 
Control.
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Plug-Ins

Using Plug & Mix plug-ins after a DSP insert on HDX systems can result in Pro Tools quitting unexpectedly or freezing, and 
offline Bounce issues. (PT-250123)

Inserting Plug & Mix Native plug-ins after a DSP insert can result in Pro Tools quitting unexpectedly. It is recommended that use Plug 
& Mix plug-ins only before any DSP insert on a track. If your session already has a DSP plug-in preceding Plug & Mix Native insert, 
remove Native Plug & Mix plug-in first and then switch the order of inserts to avoid this issue. It is a known issue that Offline Bounce 
will fail if Plug & Mix plug-ins are preceded by DSP inserts on one or more tracks. In this case, use Online Bounce to Disc.

When opening legacy sessions, the 4-band EQ III plug-in is converted to the 7-band EQ III plug-in

The AAX EQ III plug-in does not have a 4-band option. Pro Tools will automatically convert 4-band EQ III instances into 7-band in-
stances if you are using only AAX plug-ins.

When minimizing sections of the Channel Strip plug-in, graphical artifacts may occur that obscure other controls in the plug-
in window (PT-234259)

Minimizing the Dynamics or Equalizer sections of the Channel Strip plug-in may result in graphical artifacts that obscure the controls 
in other panes. If you encounter this issue, either moving the plug-in window or closing and reopening the plug-in window will force a 
redraw of the window that shows all controls correctly.

(This issue occurs with other plug-ins as well, such as Bluecat’s Patchwork plug-in.)

After updating to Pro Tools 12.8.x or higher, for installed plug-ins that support 7.x.x and Ambisonics channel formats these 
channel formats are not available from the insert selector (PT-230540)

If 7.x.x and Ambisonics formats for installed plug-ins that support these formats are not available from the insert selector after updating 
to Pro Tools 12.8.x or higher, uninstall the plug-in, launch and quit Pro Tools, and then re-install the plug-in. The next time you launch 
Pro Tools, the plug-ins should be available in all supported channel formats.

Pro Tools quits unexpectedly when opening any Facebook Audio 360 plug-in after installing the FB360 video player while 
connected over remote desktop (PT-233584)

To avoid this issue, do not operated sessions with Facebook Audio 360 plug-ins over a remote desktop connection.

The inputs of tracks fed by plug-in Auxiliary Output Sends may become unassigned if the plug-in is recalled as a Track Preset 
on another track (PT-237401)

If a track containing a plug-in feeding other tracks using Auxiliary Output Sends (AOS) is saved as a Track Preset, recalling that Track 
Preset elsewhere in a Session or Project may interfere with the routing of the tracks being fed by the original instance of the plug-in. It 
is recommended that Track Presets containing plug-ins with AOS assignments either be avoided or created in with “Plug-in Assign-
ments” unchecked in the “Track Data to Recall” dialog.

It is not possible to recall an insert from a Track preset that contains third-party multichannel plugins on a track of a smaller 
channel width than that from which the preset was created. (PT-236149)

When attempting to recall an insert from a Track preset that contains third-party multichannel plugins on a track of a smaller channel 
width than that from which the preset was created, Pro Tools does not load the preset. Instead, you are presented with a warning message 
stating that “Pro Tools cannot convert the following multichannel plug-ins that were originally saved in this track preset to the format 
of the current track. The original format of the track was “X”.” If you encounter this issue, create an instance of the Track preset for each 
needed stem format. Also, note that if an insert from a mono Track preset is recalled on a multichannel track, any third-party plug-ins 
are converted to multi-mono instead of remaining multichannel. This is only an issue with certain third-party plug-ins.

When replacing one plug-in with another, the new plug-in inherits previously auto-enabled parameters (PT-202826)

With the Plug-in Controls Default to Auto-Enabled preference enabled, all available automation parameters become unexpectedly re-en-
abled (merged) after replacing one instance of the plug-in with another. Disable this preference before replacing one plug-in with an-
other to avoid this issue.

For known issues about specific plug-ins, see the Audio Plug-Ins Read Me.
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Custom location for Avid Virtual Instrument content is not remembered (PTSW-187501)

When installing AIR Creative Collection, if you choose a custom location for the content, that location is not remembered, resulting in 
error messages when you try to use a virtual instrument plug-in (Boom, Mini Grand, or Xpand) that references a “.big” content file. The 
location is not remembered after quitting and relaunching Pro Tools. 

To avoid this error, move or reinstall the AIR Creative Collection content to the default location.

Some plug-ins require exclusive use of a DSP chip on HDX hardware-accelerated systems (PTSW-154614)

Certain plug-ins, such as ReVibe and Reverb One, use direct memory access (DMA) on HDX cards. DMA plug-ins cannot share HDX 
DSP chips with other plug-ins. Additionally, even though DMA plug-ins of the same type can share a single HDX DSP chip (for ex-
ample, multiple ReVibe plug-ins can use the same HDX DSP chip), they must be of the same channel width (DMA plug-ins of the same 
type cannot share the same HDX DSP chip if they have different channel widths).

Pro Tools stops working when opening a session with Structure Free (PTSW-131965)

When opening a Pro Tools session that uses Structure Free, Pro Tools may hang temporarily if Structure Free is looking for files in a 
directory where the files are not present.

AudioSuite and Clip Groups (PTSW-57457)

AudioSuite plug-ins handle Clip Groups in the Clip List slightly differently than audio files. With audio files, an AudioSuite process can 
be applied to all copies of a unique audio file which appear in your session by selecting your target as Clip List in the AudioSuite plug-
in window and selecting Use in Playlist. However, if your target is set to Clip List in the AudioSuite plug-in window while you have a 
Clip Group selected, Pro Tools does not recognize the Clip Group as processable audio and will present a No Audio was Selected error. 
This is because a Clip Group is not treated as audio until it is actually used in a track.

To apply an AudioSuite process to all copies of a Clip Group in a session at once, do the following:

1 Select the Clip Group to be processed.

2 From the Clip List menu, select Ungroup All. All elements of the group will remain selected.

3 Perform AudioSuite processing.

4 From the Clip List menu, select Regroup.

5 When prompted, select Modify to apply the AudioSuite Process to all copies of the Clip Group in the session, or Copy to apply it only 
to the selected Clip Group.

Rapidly showing and hiding the clip effects display during playback may cause temporary graphics artifacts (PT-214987)

Rapidly showing and hiding the Clip Effects display during playback may cause areas of the Edit Window to appear partially missing 
or in an otherwise incomplete state. Should this issue occur, stopping playback and then hiding or showing the Clip Effects display will 
return all on-screen elements to their expected locations.

Clip effects may be rendered when rendering clip gain (PT-218043)

When rendering clip gain for a clip, any active clip effects may also be rendered. To avoid unintentionally rendering clip effects, bypass 
clip effects for the clip before rendering clip gain.

HDX Systems

Pro Tools does not play back when an invalid Word Clock or AES/EBU sync source is selected on SYNC HD (PTSW-156651)

When attempting to initiate playback, playback will fail if a SYNC HD is connected to an HDX card and an Avid audio interface with 
no connections to either the word clock or AES/EBU ports. Ensure that the clock is set to a working clock source to resolve this issue.

In Avid DigiTest, the reported slot number may not correspond to the physical slot number in the computer (PTSW-155373)

In Avid DigiTest, the slot number reported for HDX cards starts from 0 on up. For example, “Slot 1” does not necessarily correlate to 
the first physical slot in the machine. If you have an HDX card that is having problems, match the Serial Number ID on the back of the 
card with the Serial Number ID displayed on the Slot Info page in Avid DigiTest.
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Pro Tools does not use HDX hardware if a Core Audio application is using HDX hardware (PTSW-155010)

When launching Pro Tools HD on an HDX hardware accelerated system, Pro Tools will use the Pro Tools Aggregate I/O as the Play-
back Engine if a Core Audio application has already engaged the HDX hardware. Be sure to quit all Core Audio applications before 
launching Pro Tools HD to ensure that Pro Tools HD can use HDX hardware.

HD Native PCIe Systems

Audible pops and clicks occur when changing buffer sizes (PTSW-125715)

Pops and clicks may occur when changing the Hardware Buffer Size (H/W Buffer Size) in the Playback Engine dialog while monitoring 
live audio through HD Native hardware. Avid recommends not changing the Hardware Buffer Size while monitoring live audio to avoid 
this problem. If you must change the Hardware Buffer Size while monitoring live audio, be sure to lower the monitoring volume to avoid 
any possible damage to your speakers.

There is no visual indication of bypassed plug-ins when Low Latency Monitoring is enabled with HD Native PCI (PT-202108)

When using Low Latency Monitoring on a system with HD Native PCI, there may be no visual indication for bypassed plug-ins. Despite 
this, enabling the Low Latency Monitoring option will in fact bypass all plug-ins in the session.

HD Native Thunderbolt Systems

HD Native Thunderbolt headphone output stops working when low latency monitoring is enabled (PTSW-169936)

The headphone output on the HD Native Thunderbolt does not function when low latency monitoring is enabled. In this case, use alter-
native monitoring source (such as an Avid HD OMNI).

HD Native Thunderbolt prevents the computer from waking after sleep (–9171 error) (PTSW-169172)

Pro Tools HD and HD Native Thunderbolt do not support the sleep function of macOS. If encountered, disconnect HD Native Thun-
derbolt to wake the computer. Disable all sleep functions in System Preferences (except display) and shut down the computer. Recon-
nect HD Native Thunderbolt and start the computer.

HD Native Thunderbolt reports a clock error at higher sample rates (PTSW-168819)

With some computers, you may encounter an audio clock error when recording at higher sample rates (such as 96 kHz) and with lower 
HW Buffer Size settings (such as 128 samples or less). In general, higher HW Buffer Size settings are recommended at higher sample 
rates. For example, at 96 kHz, a HW Buffer Size setting of 256 samples or higher is recommended.

HD Native Thunderbolt is only supported as the first or second thunderbolt device in a thunderbolt chain at sample rates up 
to 96 kHz, and it must be the only Thunderbolt device in a chain at any sample rate above 96 kHz (PTSW-168229)

HD Native Thunderbolt is only supported as the first or second Thunderbolt device in a Thunderbolt chain at sample rates up to 96 kHz, 
and must be the only thunderbolt device in a chain at any sample rate above 96 kHz. Visit the compatibility pages on the Avid website 
for more information (www.avid.com/compato).

Pro Tools quits unexpectedly when selecting HD Native Thunderbolt in the Playback Engine (PTSW-167511)

After disconnecting and reconnecting HD Native Thunderbolt from your computer, Pro Tools quits unexpectedly when selecting 
HD Native Thunderbolt in the Playback Engine. After disconnecting and reconnecting HD Native Thunderbolt, restart your computer 
to avoid this problem.

Using the HD Native Thunderbolt headphone output with surround monitoring (HDM-13)

Headphone monitoring with HD Native Thunderbolt is set to mirror Pro Tools output channels 1 and 2 on the first audio interface. To 
use HD Native Thunderbolt headphone monitoring with sessions that use surround formats (such as 5.1),change the surround monitor-
ing path in I/O Setup so that the Left channel is mapped to Output channel 1 and the Right channel is mapped to Output channel 2.
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Control Surfaces

Performance issues may occur when using EuControl with the H/W Buffer Size set to 32 in large sessions on macOS. 
(PT-248711)

When working with large sessions with the H/W Buffer Size set to 32, and with EUCON enabled, may result in CPU spikes and AAE 
–6101 errors during playback. If your session exceeds 500 audio tracks it is recommended that you use H/W Buffer Size of 64 or larger 
when EUCON is enabled.

Trim Scrub and Trim Shuttle don’t work on clips with fades (PTSW-46911)

If a clip has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around this problem, 
remove any fades on the clip, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.

Used HW output path indication (101095)

In Assign Matrix mode on your control surface, Insert mode used for the hardware output path will not have amber background indi-
cating that it's already assigned after switching to a different insert on the same track.

Color indication on plug-in controls in Learn mode (PTSW-18480)

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs in the 
plug-in window will be red if the track is in one of auto write modes. This conflicts with red color indication on the plug-in control, 
which is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.

SignalTools meter ballistics on control surfaces (PTSW-52799)

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaffected 
types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times of the affected me-
ters are not affected, only the decay times. All meter types display accurately in the plug-in window.

Channel Strip plug-in Expander/Gate meters appear in the Compressor/Limiter meter Instead of in the Expander/Gate meter in 
D-Control Dynamics section (Main Unit) (PTSW-150897)

The Avid Channel Strip plug-in uses shared meters for Expander/Gate and Compressor/Limiter processing. Because of this, both Ex-
pander/Gate and Compressor/Limiter metering appear only in the Compressor/Limiter meter in D-Control Dynamics Section (Main 
Unit).

D-Control and D-Command timecode counter does not display first hours digit with a greater than 100 fps timeline (PT-253045)

If the session timecode rate is over 100 fps, the first hours digit will be truncated on the ICON timecode counter (though it can still be 
viewed on the main counter in Pro Tools). This is a hardware limitation because the ICON counter only contains 8 digits whereas 9 digits 
would be required to display all possible frame values.

Video

Video Engine crashes when bouncing DNxHD SQ material Same as Source with blank space included in selection. (UME-1587)

When bouncing DNxHD SQ material (such as DNxHD 80 at 1080p24) to QuickTime using Same as Source, the Video Engine crashes 
if an area of blank space is included in the bounce selection. To avoid this, do one of the following: do not select any blank space, do 
not choose Same as Source in Bounce Settings, add black video to the blank space before bouncing, or use a different DNxHD bit rate 
as source material. 

Same as Source Bounce to QuickTime is not possible with ProRes, H.264, or PJPEG source media if the timeline selection 
contains blank space. (UME-1582, UME-1583)

If blank space is included in the timeline selection, and the source video codec is Apple ProRes, H.264, or PJPEG, then Same as Source 
QuickTime export is not be permitted. If it is necessary to bounce Same as Source, either use DNx source material or replace any blank 
space with black frames before bouncing. Note that bouncing from ProRes to ProRes is possible by adjusting the QuickTime Settings 
in the QuickTime Bounce dialog. 
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Video displays black (PT-260602)

If video is importing successfully without error, but only black picture and blank thumbnails are displayed, make sure that the "Shared 
LUTs" folder exists on your system. If the folder does not exist, create it and relaunch Pro Tools:

<boot drive>/Users/Shared/AvidVideoEngine/Shared LUTs 

Video fails to import with multiple codecs in a single file. (UME-1580)

A missing codec error may be encountered when importing a QuickTime video that contains multiple codecs in a single file. To avoid 
this issue, use different files for each codec.

Video clips in the AAF are in the wrong timeline location (PT-258888)

Video clips on the timeline will not be in the correct location if there are any other unrendered video clips included in the sequence. To 
avoid this issue, make sure that the AAF has all video rendered upon export from Media Composer.

Performance errors (–9171, –6101, –9093) are encountered when playing video in Pro Tools on Macs with a Retina display if the 
Display resolution is set higher than the default. (PT-280920)

When playing video in Pro tools on Macs equipped with Retina displays and running OS X 14.4.x Mojave, increasing the Resolution 
in System Preferences > Displays may cause performance-related errors (such as –9171, –6101, and –9093 errors). These errors may 
appear more frequently with larger Video Window sizes. Also, when working at a higher-than-default resolution, avoid accessing the 
workstation remotely with screen sharing (VNC or otherwise), as this may also increase the frequency of errors. To avoid this issue, ei-
ther keep the display resolution at the Default setting (or lower) or go to Setup > Preferences > Operation in Pro Tools and deselect the 
Enable GPU option in the Video section.

Mojo/Nitris DX will not lock to the expected video reference if other formats are imported after 1080p23. (PT-255575)

If importing a 1080p23 file, followed by an interlaced file, followed by another 1080p23 file, Mojo and Nitris DX will only lock to 
1080i47 video reference instead of 1080p23. This can be resolved by quitting and relaunching Pro Tools.

No picture is seen with Avid Mojo or Nitris Dx video peripherals when using non-standard size video rasters. (PT-255951)

Some video files with non-standard video raster sizes will not display properly with the Avid Mojo or Nitris Dx video peripherals. If you 
encounter this issue, try setting the engine Raster Size to a different, standard size (in the I/O section of the video track).

Video appears squished during playback on the video hardware display when using 720x486 or 720x586 raster sizes with 
certain frame rates. (PT-256019)

When using 720x486 with 23 or 24 fps, or when using 720x586 with 24 or 25 (progressive) fps, video output may display squished 
during playback on the hardware display. To avoid this issue, try setting the engine Raster Size (in the I/O section of the video track) 
to an HD raster size (such as 1080x1920).

SD video will not stretch to a 16:9 aspect ratio on the desktop display. (UME-1529)

When using 720x486 and 720x586 raster sizes, and the aspect ratio is set to 16:9 with the Stretch setting enabled, the video window size 
updates to 16:9, but the picture does not stretch. You can workaround this by setting the engine Raster Size to an HD raster, such as 
1920x1080. This can be done by Command-clicking (Mac) or Control-clicking (Windows) on the engine Raster Selector (in the I/O sec-
tion of the video track).

DNxIP automatically displays 2Kp50, 2Kp59.94, or 2Kp60 video as 1080p when outputting through the HDMI or SDI 
connections. (PT-252007)

DNxIP only outputs 2Kp50, 2Kp59/94, and 2Kp60 video over IP using the SMPTE 2110 standard. The HDMI and SDI outputs will not 
display these formats. Instead, DNxIP switches to 1080p in order to maintain the higher frame rate. Additionally, you must have in-
stalled the latest firmware update that is included with the driver. Visit www.avid.com for the latest driver compatibility information.

Playback of QuickTime video in Pro Tools may stutter or drop frames

When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter or drop 
frames. To improve results with QuickTime playback, try any of the following:

• Disable Continuous Scrolling.
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• Close unnecessary UI windows.

• Try using the DNxHD codec.

• A second Pro Tools or Media Composer Video Satellite option offers guaranteed performance for Avid video playback with a primary 
HDX or HD Native system.

QuickTime files that contain multiple CODECs may not import (UME-835)

If the Pro Tools tells you that a file cannot be imported because it may be unsupported, check to see if the file contains more than one 
CODEC. This can be done by opening the file in QuickTime player and examining the file properties. QuickTime files that contain more 
than one CODEC are not officially supported for import into Pro Tools.

1080p50 AVC-Intra100 causes an “The Avid Video Engine stopped unexpectedly” error. (PT-255898)

1080p50 AVC-Intra100 QuickTime media causes an “The Avid Video Engine stopped unexpectedly” error. To avoid this issue, use an-
other application to transcode the media to another codec, such as DNxHD.

1080p50 XDCAM 50MBPS will not draw thumbnails or display picture. (UME-1459)

1080p50 XDCAM 50MBPS QuickTime media will not draw thumbnails, and the video window displays black. To avoid this, use an-
other application to transcode the media to another codec, such as DNxHD or H.264.

1080p50 video can only be bounced as “Same as Source” (PT-236136 and PT-235110)

Pro Tools can only bounce 1080p50 video using the “Same as Source” method. Transcode is not allowed at this time. If you would like 
to change the codec or attributes of the exported video, use another application.

“No valid same as source resolution found” when bouncing DNxHR MXF files as Same As Source. (UME-1529)

DNxHR MXF files cannot be bounced using Same as Source at this time. Instead, it is possible to re-transcode the bounced file to Quick-
Time DNxHR, or you can use DNxHR QuickTime in your workflows to utilize the Same as Source bounce option with DNxHR media.

Pro Tools presents the following error: “The Video Engine has reported an error. More information is in the Video Engine log 
file” when attempting to play back video files with a resolution of 1080p50 using the AVC-Intra100 and 200 CODECs. (UME-1394) 

Pro Tools cannot play back video files with a resolution of 1080p50 using the AVC-Intra100 and 200 CODECs. Doing so results in the 
following error: “The Video Engine has reported an error. More information is in the Video Engine log file.” There is currently no work-
around for this issue, so you must transcode the media to another CODEC, such as DNxHR or Apple Pro Res.

Video media using XDCAM CODECs displays only black in a 1080p50 video project type. (UME-1392)

XDCAM codecs display only black when using a 1080p50 project type. There is currently no workaround. Transcode the media to an-
other CODEC, such as DNxHR or Apple Pro Res for use with Pro Tools.

Playback of PhotoJPEG-encoded video experiences dropped frames or stuttering (PTSW-183056)

PhotoJPEG is not a preferred CODEC for video playback in Pro Tools. It you experience performance issues with this CODEC, please 
transcode to a preferred Avid CODEC, such as DNxHD or DV25. This can be done by bouncing the file to QuickTime from within 
Pro Tools and choosing the “Advanced Settings” in the bounce window. 

Video pull factor may become invalid when video hardware is enabled (PTSW-180554)

If a software video pull factor of 0.1% is set while video hardware is disabled, enabling the video hardware may create an illegal pull 
setting. Video hardware only supports 0.1% pull ups at 24pPAL rates, and 0.1% pull downs at 25pPAL rates. If the pull rate is set to 
0.1% at any other rate while video hardware is enabled, manually select an available option from the pull menu, which may be “none.”

Video may not stay in sync when video hardware is attached and Pro Tools is locked to an external clock (PTSW-178722)

If both Pro Tools and an attached video peripheral are each resolved to an external clock, but the clock is not derived from the same 
source, video will not stay in sync. An example of this would be if the video peripheral is locked to black burst, and the audio peripheral 
is locked to an audio clock not derived from the same video black burst, such as SPDIF. In this scenario, setting the video peripheral to 
lock to its own internal clock will allow Pro Tools to compensate for video drift over time.
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Unsupported QuickTime video formats (PTSW-52140, PTSW-52155, PTSW-52156, PTSW-53625, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format movies. 
Attempting to import these will generate errors or will fail to import.

“Error reading video in the QuickTime files” when importing some MPEG 1 and 2 video files in Pro Tools (PTSW-178017)

Some MPEG1 and MPEG2 files cannot be opened by Avid applications, including Pro Tools. Transcode these files to one of our pri-
mary CODEC such as DNxHD or AppleProRes for use in Pro Tools to avoid this issue. 

3G2 file extension is not supported for video import (PTSW-178015)

Pro Tools 11 and higher provides support for the .3GP file type extension for video import. These are video files often created on mobile 
phones. The second generation of this format uses the file extension of .3G2. Files with the .3G2 file extension will be filtered out as 
unavailable for video import. These .3G2 files may be available for import if their file extension manually changed to .3GP. If the files 
remain unavailable for import after changing their extension, they will need to be converted to an explicitly supported format such as 
DNxHD or AppleProRes for use in Pro Tools.

Video file frame rates may not appear in the Workspace for files with frame rates above 60 fps. (PT-245451)

Video file frame rates may not appear in the Workspace for files with frame rates above 60 fps.  If you encounter this, delete the Work-
space.wksp database file to correct this issue.

Third-Party Video Peripherals
The following issues may occur with third-party video hardware. Please contact your hardware vendor for support.

 In some cases, video will not stay in sync over time if the video peripheral is not, or cannot, lock to video reference. If you experience 
this, a workaround is to set the Pro Tools clock to internal. This will cause the video peripheral to slew overtime and stay in sync with 
Pro Tools. (THPV-2)

 When Pro Tools is running with a Blackmagic DeckLink II Extreme or Intensity video capture and playback PCI-e card installed, 
launching Blackmagic Design’s Deck Capture utility, Final Cut Studio, or any other application which supports Black Magic hardware 
for video output, can result in system instability. To avoid any potential system instability only use one Blackmagic DeckLink–aware 
application at a time. (PTSW-19486) 

 With some peripherals video playback will be one frame out of sync with Pro Tools audio. To compensate for this, choose Setup > 

Video Sync Offset and enter a 1 frame offset. (THPV-9)

 With some video peripherals, the video output will be scrambled when video is not loaded in Pro Tools, or when the video peripheral 
is disabled. (THPV-32)

Video Satellite

“<Error encoding string>” dialog appears when Session timecode rates do not match between Pro Tools and Media Composer 
Video Satellite. (PT-260744)

After changing the timecode rate on a Pro Tools system linked to a Media Composer Video Satellite, an “<Error encoding string>” di-
alog may appear in Pro Tools in some cases. This dialog lets you know that timecode rates do not match between the two systems, how-
ever the text is currently incorrect. Once timecode rates are matched between Pro Tools and Media Composer, this message should no 
longer appear. 

Playback and locate offsets may be seen when working with a Media Composer Video Satellite that has a 119.88 fps timeline. 
(PT-255060)

A timeline offset of about 30 seconds will be seen when working with a Media Composer Video Satellite that has a 119.88 fps timeline. 
Check the Video Satellite compatibility page at www.avid.com for the latest support information and known issues.

Mismatched video reference warning with larger than HD rates (PT-233603)

If a Media Composer Video Satellite has a larger than HD Project Type, linking to a Pro Tools Satellite results in an erroneous video 
reference mismatch dialog. Despite the warning, the systems will play in sync.
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23.976 or 24 fps Sequence Start Time Ending In Digits Other than “:00” Causes Time Code Offset 

Media Composer uses NTSC or PAL time code when setting the sequence start time regardless of the format selected by the user for 
display. When you are working on a video satellite project at 23.976 or 24 fps, a Media Composer sequence with a start time that ends 
in a value other than :00 causes an offset between Pro Tools and Media Composer at the session start. For example, the start time 
45:02:10:15 (ending in :15) would cause an offset, but the start time 45:02:10:00 (ending in :00) would not.

As a workaround, always set your Media Composer sequence start time to a time code value ending in 00.

Cueing from Media Composer in a 720p Project Causes 1-Frame Offset (Item # 98460)

In 720p projects, Media Composer counts at 50 or 60 (59.94) progressive fps—depending on the project type—while Pro Tools counts 
at 25 or 29.97 frames per second. When you cue a sequence from the video satellite in a 720p project, the Pro Tools edit cursor can be 
offset by as much as one frame. 

As a workaround, cue and play back from Pro Tools when working with a 720p project in a video satellite system. This ensures that the 
two applications are always in sync. It is not possible to cue to odd 50 or 60 frame boundaries (for example, frame 47) from Pro Tools.

Audio and video may drift out of sync In Satellite Mode in certain conditions (Items # UDevC00090064, UDevC00090078, 
UDevC00088666, UDevC00089437, UDevC00087542)

When operating in Satellite mode, audio and video output from Media Composer may drift out of sync by as much as one frame in any 
of the following conditions:

• When viewing video full screen in 1394 mode. This is due to the difference between the monitor's refresh rate and the video reference 
rate.

• When the Edit Play Rate of the video differs from the frame rate of the video reference signal. (For example, this occurs with a 24p 
NTSC project with 23.976 Edit Play Rate and NTSC reference signal.)

• When looping a selection that is not aligned to video frame boundaries in Pro Tools. As a workaround, make your selection in 
Pro Tools using Grid mode with the Grid value set to 1-frame increments—especially when it is necessary to loop several times with-
out stopping.

When scrubbing with a Video Satellite, video may be offset by several frames (UME-870)

Audio/video sync is not frame accurate when scrubbing a Video Satellite. An offset of several frames may be seen between the 
Media Composer system and the Pro Tools system. To monitor frame accurate video when scrubbing, use the Pro Tools Video window. 
When done scrubbing, you can continue to monitor frame accurate video on the Video Satellite.

Pro Tools Satellite Systems

Saving logs only saves logs for linked satellite systems. (PT-248378)

It is possible to gather log files across a set of Satellite Linked systems. This can be done by going to Setup > Preferences > Operation, 
and clicking Save Logs button. When this is done, it will zip the needed logs on each of the satellite systems, but it will not zip the logs 
on the system that executed the Save command. To gather logs on that system you need to unlink satellites and save the logs again. Sav-
ing logs only needs to be done when instructed to do so by Avid Customer Care.

Synchronization

Intermittently out of sync when chasing LTC with high frame rate video reference (PT-246213)

Systems that are locked to video reference above 30 fps may experience intermittent sync offsets that can vary between each playback 
pass. These offsets may be a frame or more, depending on the frame rate. To avoid this, lock Pro Tools systems to 30 fps or lower video 
reference whenever locking to LTC or generating LTC that another system may be chasing.

General Localization

Problems Rendering Online Help if Pro Tools Language Support is set to Simplified Chinese (PT-264670)

Avid's Online Help Center is not rendered correctly inside of Pro Tools when the Language Support is set to Simplified Chinese. To 
View the Help content either switch Pro Tools language to English or open the page in an external browser.
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AAF/OMF sequences with non-English characters import with garbled clip names or won't relink (PTSW-33569, PTSW-99570, 
PTSW-33826) 

If an AAF/OMF sequence containing files or clip names with non-English characters is exported from a Mac-based Pro Tools 7.3.1 sys-
tem (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems on Windows or Mac. Con-
versely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher system (or higher) may not im-
port correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select “Manually Find and Relink,” then deselect 
all options except “Find by file ID.” Clip names may appear garbled.

Known Issues with CoreAudio Hardware Drivers
Limitations of the Avid CoreAudio Driver

When using Pro Tools HD software with HDX or HD Native hardware, Pro Tools HD software requires exclusive access to the hard-
ware. Consequently, you cannot use CoreAudio applications and Pro Tools HD software at the same time on these systems. The Avid 
CoreAudio Driver and the operating system handle transitioning between applications automatically, so there is no need to quit all 
CoreAudio applications before launching Pro Tools HD as with previous versions of this driver.

The Avid CoreAudio Driver cannot be used to preview sound files from the Mac Finder while Pro Tools is running. When a sound file 
is located in the Mac OS X navigation window, a QuickTime transport bar is displayed next to it. The QuickTime transport bar lets you 
audition the sound file. With USB audio interfaces, you can preview sound files from the Mac Finder as long as Pro Tools is not running. 
Regardless, with FireWire and Avid HD audio interfaces, the sound will always play back though the Mac built-in audio controller 
(through the Mac speaker or headphone jack). However, if you double-click a sound file, the QuickTime application launches and it can 
use the Avid CoreAudio Driver for playback. 

The Avid CoreAudio Driver cannot be used for playback of Mac System Sounds.

Pops when changing sample rates (PTSW-58770)

With the CoreAudio Manager, your Pro Tools hardware may produce a “pop” or “click” sound if Pro Tools was last used at a sample 
rate different from the one the new CoreAudio client is set to use.

Audio streaming problems when using very low H/W Buffer Sizes with 3rd party Core Audio applications (such as Logic) 
(PTSW-154719)

You may experience audio streaming problems when using Avid hardware with 3rd party applications such as Cubase or Logic and 
playing back at the lowest buffer size. The lowest supported buffer sizes when using Avid hardware are 64 at 44.1 and 48 kHz sessions, 
and 128 at 88.1 and 96 kHz.

Buffer sizes incompatible with Pro Tools hardware (39542)

In Cubase, Traktor, Live, and certain other applications, you can select Buffer Sizes that may be incompatible with your Pro Tools hard-
ware. Selecting incompatible buffer sizes results in distorted sound and may cause other problems. Please make sure to select Buffer 
Sizes listed in the following chart:

Pro Tools reports a –6101 error connecting or disconnecting headphones or audio cables from the audio output jack on your 
computer while using Pro Tools (PTSW-159325)

You may encounter a –6101 error when connecting or disconnecting headphones or audio cables from the audio output jack on your 
computer while using Pro Tools. To avoid this problem, quit Pro Tools before connecting or disconnecting your headphones or audio 
cables.

Cubase SX Buffer Sizes Supported by Avid Audio Hardware

Avid Audio Hardware Supported Buffer Sizes

HDX 128, 256, 512, 1024

HD Native 128, 256, 512, 1024

003, 003 Rack, 003 Rack+, Eleven Rack 64, 128, 256, 512, 1024

Mbox® and Mbox 2-series interfaces 32, 64, 128, 256, 512, 1024
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Pro Tools fails to launch if video hardware is seen as the default audio interface for Pro Tools (PT-223463 and PT-237198)

If video hardware is installed after installing drivers for your audio interface, Pro Tools may hang on launch. Should this occur, force 
quit Pro Tools in task manager and relaunch Pro Tools while holding down the N key on your computer keyboard. This will cause the 
Pro Tools Playback Engine dialog to launch. Change the playback engine from the video hardware to any supported audio interface.

Known Issues with Audio Interfaces

Pro Tools | MTRX Studio

Unable to find an Audio Interface attached to the first HDX card. (PT-260347)

The following intermittent error may occur when switching between Pro Tools Sessions of different sampling rates when the synchro-
nization setting in DADman Software (Conf > Sync > Sampling > Adapt to) is set to “DigiLink”: 

“Unable to find an Audio Interface attached to the first HDX card. Please check power and DigiLink cables. Click OK to rescan. Click 
Cancel to open the Playback Engine dialog and select a different device.” 

Try quitting and relaunching Pro Tools or opening the Playback Engine and selecting HDX to resolve this issue. Alternatively, set the 
Adapt to setting to “Internal.” This also requires that you manually set the MTRX Studio sample rate in DADman to match the sample 
rate of the session being opened (when relevant).

Hardware Setup displays “Loop Master: N/A” (PT-259483)

If two MTRX Studio units are connected to a single Pro Tools system, Hardware Setup displays “Loop Master: N/A.” To avoid this is-
sue, use only one unit per Pro Tools system (select the unit you want to use in the DADman Device List and deselect all other units).

Pro Tools | MTRX

The Clock Source menu cannot be changed when both MTRX and SYNC HD are connected. (PT-260808)

The Clock Source menu in Session Setup is fixed with SYNC HD selected when both MTRX and SYNC HD are connected. To use 
MTRX as the clock source, disable SYNC HD in the Synchronization tab of the Peripherals dialog.

HD OMNI

Noise in the output signal from HD OMNI with digital input (PTSW-1614)

If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you will hear 
noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the clock of the digital 
source and HD OMNI are matched correctly.

HD OMNI front panel Setup menus are unresponsive after Pro Tools quits unexpectedly (PTSW-125692)

HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink cable 
from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front panel will be unavail-
able. Power cycle HD OMNI to recover stand-alone mode.

Graphic redraw problems in the Hardware Setup dialog (PTSW-122690, PTSW-1346, and PTSW-1235)

When changing the Hardware Setup configuration for HD OMNI, it is possible to encounter graphics redraw problems in some cases. 
To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.

No sound on output after hardware reset (PTSW-126575)

After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface stops emit-
ting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem, press the ALT monitor 
button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor path. 
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Loss of Monitor path when launching Pro Tools with HD OMNI off or disconnected (PTSW-127313)

When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive Mon-
itor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output Busses.

Output paths are not automatically created in the Output page of the I/O Setup after disabling the corresponding Monitor path 
in the Monitor page of the Hardware Setup and re-assigning the Outputs from “None” to physical outputs in the Main page of 
the Hardware Setup (PTSW-127559)

After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs from “None” 
to physical outputs (such as “A 1-2”) in the Main Page of the Hardware Setup, these Output paths are not automatically created in the 
Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).

Changing Monitor path Output assignments in the Hardware Setup does not update the Output paths in the Output page of the 
I/O Setup (PTSW-127563)

When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor path Format 
to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/O Setup do not reflect the 
corresponding changes. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).

When creating new sessions, using the I/O Settings selector can result in unexpected Output assignments if HD OMNI has an 
assigned Monitor path (PTSW-123896)

If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog may be 
offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate Output paths in the 
I/O Setup (or click Default).

I/O Setup Bus page erroneously adds monitor paths (PTSW-127739)

With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None” and then 
back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup to erroneously add 
an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new Monitor abbreviation increments 
accordingly.

Mbox Pro

Pro Tools appears unresponsive with Mbox Pro (PTSW-184498)

Avid recommends connecting the Mbox Pro before powering up the computer. If Pro Tools appears to be unresponsive with Mbox Pro, 
check to ensure that the Mbox Pro is synchronized to the proper clock source (Setup > Hardware), and that the clock source and your 
Pro Tools session have matching sample rates. If Mbox Pro encounters a problem with the clock source (such as mismatched sample 
rates between the clock source and the session), Pro Tools may become unresponsive.

Pro Tools Aggregate I/O (Mac Built-In Audio)

–6101 error when previewing audio with Pro Tools Aggregate I/O (PTSW-132996)

When previewing audio in the Import Audio dialog with Pro Tools Aggregate I/O selected as the Current Engine (in the Playback En-
gine dialog), and with the macOS File view is set to Columns view, you may encounter a –6101 error. Try changing the macOS file view 
from Columns to List or Icons view, or use any of the built-in audio devices instead of Pro Tools Aggregate I/O to avoid this problem.

Changing sample rates in Audio MIDI Setup can cause Aggregate I/O to disappear in I/O Setup, resulting no audio output 
(PTSW-132281)

When Pro Tools Aggregate I/O is selected as the Current Engine in the Playback Engine dialog, changing sample rates in Audio MIDI 
Setup can cause the Pro Tools Aggregate I/O to be removed from I/O Setup resulting in no audio output. To correct this problem, click 
the Default button on the Output page of the I/O Setup.
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Error messages when opening a session with a different sample rate from the Aggregate I/O sample rate setting (PTSW-131779)

Pro Tools may indicate that a given Aggregate I/O device has not automatically adjusted its sample rate when a session with a different 
sample rate is opened. You may subsequently be presented with a dialog indicating that the session needs to be closed and reopened to 
update the sample rate setting of the Aggregate I/O device.

Renaming Pro Tools Aggregate I/O driver in AMS corrupts the driver (PTSW-131383)

If you rename the Pro Tools Aggregate I/O driver in Audio MIDI Setup (AMS), the driver be corrupted the next time you launch 
Pro Tools. If this happens, quit Pro Tools and delete the Pro Tools Aggregate I/O device from AMS. Pro Tools will re-create the driver 
the next time it is launched.

Pro Tools quits unexpectedly when enabling the built-in digital I/O (PTSW-132189)

When enabling built-in digital I/O for Pro Tools Aggregate I/O in Audio MIDI Setup, Pro Tools quits unexpectedly. To avoid this prob-
lem, enable the built-in digital I/O in Audio MIDI Setup before launching Pro Tools.

Error Messages
AAE –6101 Error (PT-236985)

Removing or inserting headphones into the Mac headphone jack results in an AAE –6101 error. Since the actual input and output con-
figuration changes when removing or inserting headphones, the transport stops. Stop the transport before removing or inserting head-
phones into the Mac headphone jack.

Error –1150 (PTSW-144422)

When launching Pro Tools HD on HDX hardware, if you encounter a –1150 error, quit Pro Tools, shut down your computer, and ensure 
that the HDX TDM cable is properly connected.

Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you will 
need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 error, quit and 
relaunch Pro Tools, open the Playback Engine dialog, and change the Number of Voices setting to use fewer voices per DSP. 

Error –9073 without reaching the 2 GB file limit

If you encounter a –9073 error, and you have not reached the 2 GB file size limit, please refer to the Knowledge Base for possible causes 
and solutions (www.avid.com/onlinesupport).

Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid –9128 er-
rors during playback with Native plug-ins or dense automation.

Error –9131 (92747a, 20843)

GUID partitioned drives will not allow you to record beyond the third partition when running on OS X. A workaround is to partition au-
dio drives using Apple Partition Map instead of GUID.

– or –

Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools.

Error –9132 (32397)

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the appropriate tracks to 
the appropriate number and format of audio tracks, and record to disk. You can then use the resulting audio files as you would have used 
bounced files.
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Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid –9155 
errors during playback with dense automation.
 Pro Tools and Pro Tools | Ultimate Software 2020.9 on macOS 10.13.6, 10.14.6, and 10.15.6 — 8/29/20 31


	Compatibility
	General Compatibility
	Pro Tools | HDX and Pro Tools | HD Native Systems
	Eleven Rack
	VENUE
	S6
	Dolby Atmos
	Ambisonics

	Known Issues
	General Pro Tools Issues
	Editing
	Projects and Collaboration
	Ableton Link
	I/O Setup
	File and Disk Management
	Elastic Audio
	Track Commit and Track Freeze
	MIDI
	Plug-Ins
	HDX Systems
	HD Native PCIe Systems
	HD Native Thunderbolt Systems
	Control Surfaces
	Video
	Third-Party Video Peripherals
	Video Satellite
	Pro Tools Satellite Systems
	Synchronization
	General Localization

	Known Issues with CoreAudio Hardware Drivers
	Known Issues with Audio Interfaces
	Pro Tools | MTRX Studio
	Pro Tools | MTRX
	HD OMNI
	Mbox Pro
	Pro Tools Aggregate I/O (Mac Built-In Audio)

	Error Messages

